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Section 2 
 

Advanced Cell Formatting 

By the end of this Section you should be able to: 

Apply Wrap Text 
Use Merge and Shrink to Fit 

Change Text Orientation 
Remove Cell Formatting 
Use the Format Painter 

Use Paste Special 
Add and Remove Conditional Formatting 

Use AutoCalculate 
Use AutoCorrect 
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Exercise 9 - Wrap Text 
Guidelines: 

Wrap Text is used to fit data into cells without widening the columns, by using 
more than one row within a cell. The row height is increased automatically, if 
not previously set manually. 

Actions: 

1. Open the workbook League. This is an Ice Hockey league table. 

2. The numbers in the centre of the table are small but the titles are relatively 
long. Select columns B to I and change all the column widths to 9.00 (68 
pixels). 

3. Display the Home tab, select the range B3:I3 and Center align the labels. 

4. With the range still highlighted, click the Wrap Text button, , found in 
the Alignment group. Where necessary the text in the cells has been 
wrapped onto a new line so that it can all be seen, the row height is 
adjusted automatically. 

 

Note: If the row height had previously been set manually, then as with adding a 
larger font, the row height would have to be adjusted manually. 

5. Print a copy of the worksheet. 

6. Leave the workbook League open. 
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Exercise 10 - Shrink to Fit 
Guidelines: 

Shrink to Fit is another way to display all the text in a cell. It reduces the size 
of the font so that the contents fit into the cells. 

Actions: 

1. Open the workbook League, if not already open. 

2. Highlight the range B3:I3 and click the Alignment tab dialog box launcher 
to display the Format Cells dialog box. 

 

3. Uncheck Wrap text and check Shrink to fit under Text control. 

 

4. Click OK. The text reverts to a single line and the font size is reduced 
where necessary so that all the text can be seen in each cell. This is 
rarely used for a range of cells, as different cells will have different sized 
fonts. 

5. Click Undo to remove the Shrink to fit and re-apply the Wrap text. 

6. Leave the workbook open. 
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Exercise 11 - Merge Cells 
Guidelines: 

Merge cells is used to combine two or more cells into one. Very useful when 
creating a form, e.g. an order or invoice with variable width columns, or when 
placing a title across several columns. 

Actions: 

1. Open the workbook League, if not already open. 

2. To centre the title across columns A to I, highlight the range A1:I1 and 

click the Merge and Center button,  in the Alignment group. 

 

3. The cells are Merged to make one cell, A1. 

4. To remove the merging, the Merge and Center button can be used again. 

Click on cell A1 and click the Merge and Center button,  again. 

Note: Merging can also be controlled using the Format Cells dialog box, check 
or uncheck the Merge cells option. 

5. Make Sheet2 active. This blank sheet is to be used for experimenting with 
Merge cells. Select the range B2:B6 and click the Merge and Center 

button, , (apply another type of alignment if centre is not appropriate). 

6. Enter Fred in cell B2. Merge the ranges D2:F2 and D4:F6. Enter Fred in 
cells D2 and D4. 

 

7. With cell D4 selected, click the Middle Align button, , to place Fred in 
the centre of the merged range D4:F6. 

8. Click on cell D2 and remove the cell merging. 

9. Leave the workbook open. 
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Exercise 12 - Text Orientation 
Guidelines: 

Cell contents can be displayed vertically or at any angle in the cell. This is 
called Orientation. 

Actions: 

1. Open the workbook League, if it is not already open. 

2. On Sheet2, click on the merged cell D4 and click the Orientation button, 

 and select Angle Counterclockwise. This turns the text through 45 
degrees. 

3. If greater control is required, with D4 still selected, click the Orientation 
button and select Format Cell Alignment. The Orientation box controls 
the angle at which the cell contents are displayed. 

 

4. To rotate the contents, either type a number of degrees in the Degrees 
box, use the Degrees spinner, drag the line round in the picture or click 
the markers around the semicircle. Change the angle of the text to 30 
degrees, using any method. Click OK. 

5. Click on the merged cell B2 and change the contents so that it reads 
vertically down, letter by letter, by clicking the Orientation and choosing 
Vertical Text. 

6. Click the League Table sheet tab. Highlight the range B3:I3 and rotate 
the text through 90 degrees, using the Orientation button and Rotate 
Text Up. 

7. Change the widths of columns B through to I to 4.00 units. Right align the 
contents. This method of text orientation is used for record sheets, where 
names are displayed across the top and marks or grades are entered 
underneath. 

8. Print a copy of the worksheet, centred horizontally. 

9. Leave the workbook League open. 
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Exercise 13 - Remove Cell Formatting 
Guidelines: 

Formatting affects the way a cell and its contents appear. Individual formatting 
can be changed by applying different options, e.g. applying a different font 
style. The Clear command has options to remove: content but not formatting; 
formatting but not content; or both formatting and content. 

Actions: 

1. The workbook League should still be open, if it is not, open it. 

2. On Sheet2, click on cell B2. This cell has formatting in the form of merged 
cells and text orientation applied. 

3. Click the Clear button, , in the Editing group. 

 

4. Select Clear Formats. All the formatting is removed, but the content 
remains in cell B2. 

5. Click on cell D4 and press <Delete>. This is the equivalent of the 
command Clear Contents. 

6. With the D4 still selected type George and press <Enter>. The formatting 
of this cell has remained even though the content was removed. 

7. Select D4, click Clear and select Clear All. The content and formatting 
are removed. Enter the text George again to prove that the formatting is 
no longer applied. 

8. Click the League Table sheet tab and clear the formatting from the cell 
E3 and the range A4:A10. 

9. Leave the workbook League open. 
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Exercise 14 - Format Painter 
Guidelines: 

When several different formats have been added to a cell, these formats can 
be painted to any other cells using the Format Painter. 

Actions: 

1. The workbook League should still be open, if it is not, open it. 

2. On the League Table sheet, click on cell D3. This is a cell that has all the 
formatting still applied. 

3. On the Home tab, click the Format Painter button,  in the Clipboard 

group. The cursor changes to a . To apply the formatting, click on 
cell E3. All the formatting features from D3 are now applied to E3. 

4. Click on cell A3.  

5. Click the Format Painter button,  and then click and drag the range 
A4:A10 to paste the formats to the range. 

6. Click on cell B4, change the font colour to Orange and the font size to 
12pt. 

7. Double click on the Format Painter to activate it for multiple use. 

8. Click on cell C4. The formats are pasted and the Format Painter is still 
active. 

9. Click on cell D4. The formats are pasted again. 

10. Click and drag the range E5:H5 on releasing the mouse the formats are 
applied to that range. 

11. Click on any cells and select any ranges in the table to paste the formats. 

12. Press <Esc> or click the Format Painter button, again to cancel it. 

13. Close the workbook without saving. 
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Exercise 15 - Paste Special 
Guidelines: 

When using Copy and Paste or Cut and Paste, the default is to paste the cell 
exactly as it was originally. Paste Special is used to paste cell information 
when a complete copy is not required. For example, Paste Special can: 

Paste only formulas, values or formats. Pasting values from cells that 
contain formulas is a way of fixing the data, as it will never then be 
recalculated. 
Combine with existing values using an operation, e.g. adding, subtracting, 
etc. 
Transpose ranges (change a spreadsheet round by converting rows to 
columns and columns to rows). 
Paste links to the original data (covered in a later section). 

Actions: 

1. Open the workbook Finances. 

2. Open the workbook Outgoings and select the range A1:L10 and click on 

the Copy button, , in the Clipboard group. 

3. Click on the icon representing the Finances workbook on the Taskbar to 
make it active. 

4. Click on cell B5. Click the Paste button to paste the contents normally. 

5. Data can be pasted using a mathematical operation. Open the file 
Income. 

6. Highlight the range A1:L2, the income figures. 

7. Click the Copy button. 

8. Switch back to Finances using the Excel icon on the Taskbar. 

9. The income figures are to go into the range B2:M3 but this range already 
contains data, which would be overwritten if a normal paste was used. To 
add the new data to the original data, select cell B2 then click the Paste 
drop down arrow and select Paste Special. 

 
 
 
 
 
 

continued over 
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Exercise 15 - Continued 

 

10. Under Operation click Add to add the two sets of figures together, then 
click OK. The data is now combined. 

Note: The Add operation was used in this example. Subtract, Multiply and 
Divide work in a similar way. 

11. It may be necessary to convert formulas to values because the numbers 
are final, e.g. a VAT return or expenditure after the month end, etc. Using 
the Finances workbook, January has ended and the figures in column B 
are required to be converted to values. Check the cells B4, B15 and B16 
to see that they currently contain formulas. 

12. Select the range B2:B16 and click the Copy button, . 

13. Without moving the selection, click the Paste drop down and select Paste 
Special. 

14. Under Paste, select the Values option and click OK. Press <Esc> to 
remove the selection. 

15. Check that the cells B4, B15 and B16 now contain values. 

Note: Remember that this process removes formulas and therefore the 
worksheet cannot be used again. If repeated use is required, create and 
use a template. 

16. Save the workbook as Finances2 and close it. 

17. Close the workbooks Income and Outgoings without saving. 
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Exercise 16 - Conditional Formatting 
Guidelines: 

As well as applying formatting to certain cells, it is possible to apply different 
formatting to cells depending on the values within those cells. Selected cells 
can be compared to a value, or the results of a formula, to decide which format 
should be used. This is called Conditional Formatting. 

Multiple conditions can be used to determine the formatting for the same cell, 
so for example, a cell could be coloured red if it is below a certain value and 
blue if it is greater than another value. 

Actions: 

1. Open the workbook Retail. 

2. Highlight the Turnover figures, the range B4:M4. 

3. With the Home tab displayed, from the Styles group, click Conditional 
Formatting. 

4. There are several types of preset formatting available from the list but 
select New Rule. The New Formatting Rule dialog box is displayed. 

5. Select Format only cells that contain. 

 

6. In the drop down criteria box (between) select less than or equal to. 
Enter the value 19000 in the next box. 

 
 
 

continued over 
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Exercise 16 - Continued 

 

7. Click the Format button and select the text colour Red. Click OK. Click 
OK again to apply the rule. 

8. To add another condition to the same range, click the Conditional 
Formatting icon and select New Rule. Select Format only cells that 
contain, again. Select greater than and enter 25000 in the next box. 
Format the text to be bold and blue. Click OK and OK again to apply the 
formatting. 

9. Highlight the range B14:M14, apply the conditional formatting, values less 
than the average of the range =Average($B$14:$M$14). Format the 
range with a pale green cell shading using the Fill tab and More Colors 
option. Click OK, OK and OK again. 

10. To remove Conditional Formatting, select the range B4:M4, click 
Conditional Formatting menu and select Manage Rules. 

 

 The current selection has two rules applied to it. To view all the rules, select 
This Worksheet from the Show formatting rules for box. 

11. Select the Cell Value > 25000 rule and click the Delete Rule button, 

. Click OK. All values of over 25000 should now not be blue 
or bold. 

12. Experiment with adding and removing conditional formats to experience 
the power of the feature to highlight results in a way that had not been 
possible before. 

13. Close the workbook without saving. 
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Exercise 17 - AutoCalculate 
Guidelines: 

AutoCalculation displays the results of common mathematical functions on the 
Status Bar without the need to enter them. 

Actions: 

1. In a blank workbook, enter a list of numbers from B2 to B8. 

2. Select this range B2:B8 and note the AutoCalculation in the Status Bar 
at the right, given as Average: ….     Count: …..      Sum: …. An example 
is shown below: 

 

3. With this range still selected, click the right mouse button on the Status 
Bar to display a list of Status Bar options. Mathematical options are listed 
near the bottom. 

 

4. Options can be checked or not as required. Click Maximum and then click 
away from the shortcut menu. Max is added to the display. 

5. Right click on the Status Bar and uncheck Maximum to remove it. Close 
the shortcut menu. 

6. Close the workbook without saving. 
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Exercise 18 - AutoCorrect 
Guidelines: 

Common spelling or typing errors can be corrected automatically using 
AutoCorrect. Corrections for personal errors can be added. Any entries will 
remain programmed until deleted. 

Actions: 

1. In a blank workbook, click the File tab then Options. 

2. Display the Proofing section and click the AutoCorrect Options button. 

3. In the Replace box, type ferd and in the With box type Fred. 

 

4. Click Add to add this replacement to the list. Click OK. Click OK again to 
close Excel Options. 

5. In cell B2, type ferd, select <Enter> and the correction is automatically 
made. 

Note: This can lead to problems if the text you are replacing is actually required 
in a cell. To switch the autocorrect feature off, display Options, Proofing 
and AutoCorrect Options and uncheck the Replace text as you type 
box. Click OK. 

6. Display the AutoCorrect Options again and find ferd in the list.  Select it 
and Delete it.  Select OK to close the dialog box. Click OK again. 

7. In cell B4, enter ferd, it now stays unchanged. 

8. Close the workbook without saving. 



Excel Intermediate Open Learning 

Excel 2010 34 © CiA Training Ltd 2010 

Exercise 19 - Revision: Advanced Cell Formatting 
1. Start a new workbook and create the following invoice, using the 

appropriate cells. The merge cells feature is used extensively. 

 

2. The borders are gridline thickness, except for a solid line around the 
invoice block B9:J25 and the Terms block, C27. 

3. Merge the title across the range A1:J1 and vertically centre it. 

4. The Customer and Invoice details are merged cells. 

5. The item lines are merged into one cell, line by line, including the title 
Description. 

6. Apply Wrap Text to the box next to Terms and the Unit Price cell. 

7. The cell A9 is the range A9:A25 merged, the text is vertically orientated, 
horizontally and vertically aligned. 

8. The SubTotal formula in cell J22 is the sum of the range J10:J21. VAT in 
cell J24 is the SubTotal and Post & Packing multiplied by 0.175. 

9. The Totals for each invoice line are Qty multiplied by Unit Price. To 
suppress the display of zeros, display the File tab, select Options and in 
the Advanced section under Display options for this worksheet, 
uncheck the relevant option. The grand Total in cell J25 is the sum of the 
three cells above it. 

10. Save the workbook as Created Invoice, print it and then close it. 


